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1 Information on the current version and 

history 

1.1 New functions 

The following table lists the new functions and indicates the version in which the new 

function was introduced: 

New functions of firmware V2.20: 

Version Function 

V2.20 

Supports Windows 10 IoT Enterprise LTSC 2021. Hint: Instruments shipped with this 

Windows 10 version require FSV/A3000 firmware version 2.20 or higher. Older firmware 

versions do not support Windows 10 IoT Enterprise LTSC 2021. 

V2.20 

R&S FSV3-B21: 

The IF and LO frequency are now shown in the external mixer dialog (Input / Output -> 

Input Source Config -> External Mixer) in I/Q mode. 

V2.20 

Supports R&S FSV3-B601 and R&S FSV3-B1001: 

Enabling up to 1000 MHz analysis bandwidth on RF input for frequencies below 7.5 

GHz. 

V2.20 

Supports new software options: 

R&S FSV3-K147C: 5GNR Combined Multi Carrier Measurements. 

R&S FSV3-K575: I/Q noise cancellation (EVM enhancement through wideband receiver 

noise reduction) supported in R&S FSV3-K91, R&S FSV3-K144 and R&S FSV3-K145. 

I/Q Analyzer is supported by using SCPI commands. 

V2.20 

R&S FSV3-K8: 

Supports “Header Info (Packet header and PDU header information)” for BR/EDR and 

LE supported packet types. 

Supports HVx, AUX, POLL, FHS packets for BR. 

Supports relative channels numbers in IBSE. 

Supports LE channel numbers in IBSE. 

Supports CTE in LE1M and LE2M. 

LE2M IBSE is now measured over full bandwidth. 

V2.20 

R&S FSV3-K18: 

Power unit is now selectable between Watt and dBm. 

Frequency domain resolution is now configurable by selecting a resolution bandwidth 

(RBW). 

Option K18M now also supports the generalized memory polynomial DPD (GMP). Both 

generalized and standard memory polynomial DPD now support loading coefficients 

from file and applying them to any given waveform. 

V2.20 

R&S FSV3-K30:  

Supports external frontends as input source. 

Supports new displays and measurement results for P Hot and P Cold. 
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Adds new DUT modes: System Downconverter Fixed LO and System Downconverter 

Fixed IF. 

V2.20 
R&S FSV3-K60: 

FM video filter bandwidth is now continuously adjustable. 

V2.20 

R&S FSV3-K70:  

DVB-RCS2 configuration tool offers the selection of the Tx filter roll-off factor (0.05 / 0.1 / 

0.2). 

V2.20 

R&S FSV3-K91:  

Supports “Smart Auto Level” for improved EVM performance at center frequencies < 7.5 

GHz also for R&S FSV3-K575 I/Q noise cancellation. 

V2.20 
R&S FSV3-K144:  

Adds limit check for EVM PDSCH 1024QAM. 

V2.20 
R&S FSV3-K144/K145: 

Supports R&S FSV3-B271 Analog baseband inputs. 

V2.20 

In I/Q analyzer, R&S FSV3-K144/K145, R&S FSV3-K100/K104 and R&S FSV3-K7 the 

I/Q data export now supports the following additional data formats: .iqw, .csv, .mat 

(Matlab v4 and Matlab v7.3), .aid. 

V2.20 

R&S FSV3-K144/-K145/-K147/-K148/-K171/-K175: 

Supports “Smart Auto Level” for improved EVM performance now for all 3GPP test 

models and arbitrary 5G signals at center frequencies < 7.5 GHz. 

Supports “Smart Auto Level” also for improved EVM performance with R&S FSV3-K575 

I/Q noise cancellation. 

V2.20 

R&S FSV3-K171: 

Supports channel bandwidth 3 MHz for 3GPP release 18. 

Supports 3GPP test models for FR2-2. 

V2.20 

R&S FSV3-K175:  

Supports additional ORAN test cases 3.2.6.1.1-5 for FR2 and 50/200/400MHz channel 

bandwidth. 

  

V2.20 

R&S FSV3-K553: 

Supports “Zero Span” based measurement modes. 

Supports “FFT Sweep” based measurement modes. 

V2.20 Supports R&S NRP18P/40P/50P and NRP90S[N] power sensors. 

V2.20 Supports R&S RT-ZM130 and RT-ZM160 probes. 

 

New functions of firmware V2.10: 

Version Function 

V2.10 

Supports R&S FSV3-B271 Analog Baseband Inputs with 200 MHz analysis bandwidth 

for I and for Q Input each. Available in IQ Analyzer and R&S FSV3-K91 (WLAN) 

application. 
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V2.10 
Supports new software option R&S FSV3-K96:  

Vector signal analysis software for generic OFDM signals. 

V2.10 Supports display and control of video bandwidth Lin/Log State in the user interface. 

V2.10 

Additional 51 kHz, 150 kHz, 250 kHz, 400 kHz, 450kHz 3dB Gauss filter available for 

spectrum analyzer mode. 

These bandwidths can only be selected by entering the numeric values directly. 

V2.10 
Supports R&S FS-SNS90/SNS110: Smart noise sources for noise figure and gain 

measurement. 

V2.10 

Supports selection of input optimization Low Noise or Low Distortion. This setting is 

available for R&S FSV3-B271 Analog Baseband Inputs and for R&S FSV3-B200/B400 

Bandwidth Extension. 

V2.10 
R&S FSV3-K7: 

Supports Online demodulation signal output to Video Out connector. 

V2.10 
R&S FSV3-K18:  

New feature: FFT parameters for all frequency domain displays are now configurable. 

V2.10 
R&S FSV3-K40:  

Supports Online IQ mode. 

V2.10 

R&S FSV3-K91:  

Supports “Smart Auto Level” for improved EVM performance at center frequencies < 7.5 

GHz. 

FSV3-K91AX/BE: Supports ‘AM/AM’, ‘AM/PM’, ‘AM/EVM’. 

FSV3-K91/N/AC/N/AX/BE: Supports ‘Amplitude Tracking vs Symbol’ result. 

FSV3-K91/N/AC/N/AX/BE: ‘Tracking/Channel Estimation’ dialog provides ‘I/Q Mismatch 

Compensation Per Subcarrier’ feature. 

V2.10 

R&S FSV3-K144/-K145/-K147/-K148/-K171/-K175: 

Supports “Smart Auto Level” for improved EVM performance for FR1 3GPP test models. 

Supports more than 8 component carriers in multi carrier ACLR. 

Evaluates Bit/s in bitstream. 

K148: N_ID^1 for the sequence generation of PDSCH/PUSCH DMRS. 

K171: Automatic determination of capture time in FR2-2. 

K171: UL FR1: EVM calculation for reported transient period. 

K175: Supports test model 3.2.5.1.1 in UL. 

V2.10 
R&S FSV3-K553: 

Supports LO IN/OUT settings of external frontend.  

 

New functions of firmware V2.00: 

Version Function 

V2.00 Supports preamplifier (1330.4049.49) for R&S FSV3050 and R&S FSVA3050. 

V2.00 

R&S FSV3-K553 External frontend control: 

Support for manual attenuation setting of the base instrument analyzer with active 

external frontend input. 
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Firmware version V2.00 includes the external frontend microcontroller firmware V2.1.15. 

Please note: If the firmware versions installed on the analyzer and the external frontend 

are incompatible, connection to the external frontend is rejected. In this case, update the 

external frontend firmware (Input Source Config > External Frontend > Global Config > 

FW Update dialog). 

Supports new revisions of External Frontend frontend boards: 

• FE50DTR_Frontend A/B, part number 1347.4476.02, revision >= 4.00 

See table “Setup – System Config -> Hardware Info”, column “Rev”. 

V2.00 

Supports new software options: 

R&S FSV3-K175: O-RAN measurements in line with O-RAN.WG4.CONF.0-v05.00. 

R&S FSV3-K8: Bluetooth®/EDR measurements. 

R&S FSV3-K60P: Transient phase noise measurements. 

V2.00 

R&S FSV3-K144/-K145/-K147/-K148/-K171: 

Signal demodulation and analysis in line with TS38.211 V17.3.0. 

Time Alignment, Transmit On/Off Power, ACLR, SEM measurements in line with 

TS38.141-1/2 V17.6.0, TS38.521-1 V17.5.0 and TS38.521-2 V16.12.0. 

PN sequence can optionally be generated for only DL symbols. 

Evaluation of maximum crest factor over multiple frames. 

Visualization of boosted / de-boosted allocations in constellation diagram. 

Allocation specific color coding in constellation diagram is now supported. 

V2.00 
R&S FSV3-K18: Amplifier measurements: 

New results “AM/AM and AM/PM curve width peak-peak”. 

V2.00 R&S FSV3-K70: LSB first bit ordering is now supported as demodulation parameter. 

 

New functions of firmware V1.90: 

Version Function 

V1.90 

Supports new models for 50 GHz: 

• R&S FSVA3050 

• R&S FSV3050 

V1.90 Supports option R&S FSV3-B54G “Frequency extension 54GHz” for R&S FSVA3050. 

V1.90 Supports option R&S FSV3-VSE “Local VSE Enabler”. 

V1.90 Supports R&S FS-SNS18 smart noise source for noise figure and gain measurements. 

V1.90 

Spectrum analyzer mode: 

Additional 8 MHz 3dB Gauss filter available for spectrum analyzer mode. 

The 8 MHz bandwidth selection needs numerical entry. 

V1.90 R&S FSV3-K18: New features “Power Servoing” and “Detailed MSE”. 

V1.90 

R&S FSV3-K106: 

Supports save & load user defined sets 

Supports NB-IoT downlink test model (N-TM)  

Supports bitstream result display with BER results 

Added NPDSCH settings 
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V1.90 

R&S FSV3-K171: 5G NR R17 extension for uplink/downlink measurements.  

Supports frequency range FR-2-2 (FR2-2 Channel bandwidth; 480 kHz and 960 kHz for 

BWP, SS/PBCH blocks, PRACH; enhanced PUCCH formats 0/1/2/4).  

1024 QAM modulation.  

35 MHz and 45 MHz channel bandwidth. 

3GPP test models 2b and 3.1b according to TS38.141-1 V17.5.0. 

R&S FSV3-K144/-K145/-K147/-K148: 

Signal demodulation and analysis in line with TS38.211 V17.1.0. 

Time alignment, transmit on/off power, ACLR, SEM measurements in line with 

TS38.141-1/2 V17.5.0, TS38.521-1 V17.4.0 and TS38.521-2 V16.11.0. 

BWP specific filtering. 

Multi numerology in uplink. 

V1.90 
R&S FSV3-K553 “External frontend control”: 

Shows “IFCorr” in info bar, if external frontend IF cable correction is active. 
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1.2 Modified functions 

The following table lists the modified functions and indicates the version in which the 

modification was carried out: 

Modifications of firmware V2.20: 

Version Function 

V2.20 
As of Version V2.20, not only the Setup EXE file is signed, but also the individual MSI 

files inside the Setup EXE file, making the firmware installer even more secure.  

V2.20 Sweep time has been improved when using MIL 6dB filters 

V2.20 
If the last self-alignment is older than [X] days (default: 30), an info message is shown. 

A SCPI command and status bit was added accordingly. 

V2.20 

R&S FSV3-K100/K104: 

Feature improvement for "Custom Sync Weight" with multiple frames. 

CONFigure[:LTE]:DL[:CC{cc}]:SYNC:CSWeight:NOFRame 

CONFigure[:LTE]:DL[:CC{cc}]:SYNC:CSWeight:ANTenna{ant}:FHFRame{fr}:REAL 

<numeric> 

CONFigure[:LTE]:DL[:CC{cc}]:SYNC:CSWeight:ANTenna{ant}:FHFRame{fr}:IMAGinary 

<numeric> 

CONFigure[:LTE]:DL[:CC{cc}]:SYNC:CSWeight:ANTenna{ant}:SHFRame{fr}:REAL 

<numeric> 

CONFigure[:LTE]:DL[:CC{cc}]:SYNC:CSWeight:ANTenna{ant}:SHFRame{fr}:IMAGinary 

<numeric> 

V2.20 
R&S FSV3-K144/-K145: Selected Frame button in Result Summary table header is now 

enabled in multi component carrier case for view mode All. 

 

Modifications of firmware V2.10: 

Version Function 

V2.10 

R&S FSV3-K18:  

Additional synchronization step “2nd stage Synchronization” synchronizes even in 

sparsely allocated conditions. 

V2.10 
R&S FSV3-K18M:  

Memory polynomial coefficients: scaling changed. 

V2.10 

R&S FSV3-K54:  

The status bar warning “Increase sweep points” is now displayed if less than 2 sweep 

points cover the resolution bandwidth. 2 sweep points within the resolution bandwidth is 

still according to EMI standards. The limit has former been at 3 sweep points. 

V2.10 

R&S FSV3-K144/-K145:  

For multi carrier measurements, the calculation of the nominal channel spacing was 

adapted according to 38.104 V17.7.0. For MC ACLR / CACLR / MSEM, the SCS input 

setting has been removed and the sub-block gap calculation was adapted accordingly. 

V2.10 
R&S FSV3-K145:  

In UL TP, the value range of the decoding parameter I_MCS is extended. 
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V2.10 

R&S FSV3-K171:  

For FR2-2, the default value for the number of slots per frame to analyze is adapted to 

80 according to 38.141-2 V17.9.0. 

 

Modifications of firmware V2.00SP1: 

Version Function 

V2.00SP1 Modified YIG preselector centering algorithm for production reasons. 

 

Modifications of firmware V2.00: 

Version Function 

V2.00 
Measurements in FFT Mode have been optimized: especially measurements with larger 

spans are significantly faster now. 

V2.00 
R&S FSV3-K171: Updated available number of resource blocks per SCS and bandwidth 

part for FR2-2 according to 38.101-2 v17.6.0. 

V2.00 
R&S FSV3-K70: Predefined digital standards for Bluetooth® now set the bit ordering to 

LSB first. 

V2.00 Updated NGINX to version 1.20.2. 

V2.00 

R&S FSV3-K144:  

For NR-TM 3.3 and 3.2, the n_RNTI=0,2 PDSCH allocation is no longer taken into 

account for the EVM calculation. 

 

Modifications of firmware V1.90: 

Version Function 

V1.90 
R&S FSV3-K144: The preamplifier can now be configured via the amplitude softkey 

menu. 

V1.90 
Detailed version information of the operating system is now displayed in the “Versions + 

Options” dialog. 
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1.3 Improvements 

The following tables list the improvements and indicate since which version the issue 

could be observed: 

Improvements of firmware V2.20: 

since Function 

V2.00 
Using external generator control FSV3-B10 with active YIG-Preselector resulted in level 

variances for measurement frequencies above 7.5 GHz. This issue is solved. 

V2.00 

In certain FFT based measurements there was a slight level variance (still within 

specifications) in the first single sweep after a continuous measurement. This issue is 

solved. 

V1.10 
It was not possible to change the number block behavior to numerical ([SETUP]-

>System Config -> Config -> „Number Block Behavior“). This issue is solved. 

 

Improvements of firmware V2.10: 

since Function 

V1.90 
In Spectrum Emission Mask measurements for specific measurement configuration, 

some results were not displayed. This issue is solved. 

V1.10 
R&S FSV3-K91AX/BE:  

For HETB, EHTTB PPDUs reduced EVM variance. 

V2.00 

R&S FSV3-K100:  

Custom sync weight can be set per antenna in MIMO configuration.   

CONFigure[:LTE]:DL[:CC{cc}]:SYNC:CSWeight:ANTenna{ant}:FHFRame:REAL 

<numeric> 

CONFigure[:LTE]:DL[:CC{cc}]:SYNC:CSWeight:ANTenna{ant}:FHFRame:IMAGinary 

<numeric> 

CONFigure[:LTE]:DL[:CC{cc}]:SYNC:CSWeight:ANTenna{ant}:SHFRame:REAL 

<numeric> 

CONFigure[:LTE]:DL[:CC{cc}]:SYNC:CSWeight:ANTenna{ant}:SHFRame:IMAGinary 

<numeric> 

V2.00 

R&S FSV3-K144:  

When the signal configuration was modified after a test model was loaded, the former 

test model name was still displayed in the signal configuration dialog. The issue is 

solved. 

V2.00 

R&S FSV3-K144:  

In 5G MC ACLR, the response to the remote query of the result summary (e.g. 

CALCulate1:MARKer1:FUNCtion:POWer1:RESult:DETails? GACLr) was missing 

separating commas. The issue is solved. 

V2.00 

R&S FSV3-K144:  

In 5G ACLR, the ASCII trace export did not work via the trace dialog. The issue is 

solved. 

V2.00 

R&S FSV3-K144:  

The EVM vs. Symbol X Carrier results could not be exported in binary format. The issue 

is solved. 
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Improvements of firmware V2.00: 

since Function 

V1.90 

R&S FSV3-K18: Amplifier measurements: 

Phase display provides unwrapping. 

The display is now additionally updated after changing the phase unit. 

K18M modelling algorithms have been optimized for highly non-linear DUTs. 

 

Improvements of firmware V1.90: 

since Function 

V1.10 
The export of averaged I/Q data using “TRAC:IQ:DATA?” with “TRAC:IQ:AVER ON” 

returned zero values only. This issue is solved. 
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1.4 Known issues 

The following tables list the known issues and indicate since which version the issue 

could be observed: 

since Function 

V2.20 
Clicking on the Config tab (Setup -> System Config -> Config) with the “Help Pointer”  

will show an empty help page. 

V2.20 
On Windows 10 IoT Enterprise LTSC 2021, the “File Explorer” button in file dialogs (e.g. 

File -> Recall -> File Explorer; File -> Save -> Save -> File Explorer) is disabled. 

V2.20 R&S FSV3-K171: PBCH decoding performance reduced for 3 MHz channel bandwidth. 

V1.70 

R&S FSV3-B10: With R&S SMBV100A firmware version < 4.70.108.41 the TTL 

synchronization via handshake might lead to an TTL handshake error. In this case, 

upgrade the R&S SMBV100A firmware to version 4.70.108.41 or higher. 

V1.70 R&S FSV3-K18: Zeroing, Meas->Ref, and Unit settings are currently not available in 

power sensor mode. 

V1.60 R&S FSV3-K980: For very large HUMS database sizes, the remote command 

DIAGnostic:HUMS[:ALL]? may fail. In this case, use SNMP or REST (Representational 

State Transfer). 

V1.60 The floating license server has to be configured by the instrument’s webpage with 

firmware version 1.60 or above. 

Open the license server web page with your own browser with the instrument’s IP 

address followed by a colon and the number 9444, e.g. http://10.11.12.13:9444”, select 

tab “Configuration – Floating license servers” and enter the related data. 

 

Changing the configuration by using the instrument’s dialog will show an error message. 

V1.60 R&S FSV3-K553: 

When trying to connect to an external frontend providing an invalid host name or 

aborting (e.g. setting connection state to OFF) an ongoing connection attempt, the 

application becomes unresponsive for a few seconds.  

V1.60 R&S FSV3-B21:  

Firmware version V1.60 and above fully support the following applications: 

• Spectrum 

• I/Q Analyzer 

• R&S FSV3-K7 – Analog Modulation Analysis 

• R&S FSV3-K18 – Amplifier Measurements 

• R&S FSV3-K60 – Transient Measurements 

http://10.11.12.13:9444/
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• R&S FSV3-K70 – Vector Signal Analysis 

• R&S FSV3-K144 ”3GPP 5G NR DL Measurements”. 

• R&S FSV3-K145 “3GPP 5G NR UL Measurements”. 

Although activation dialogs for external mixers may be accessible in other applications, 

this feature is not yet fully supported and tested in these applications. 

V1.30 R&S FSV3-B1000: 

Trigger Output types “Trigger Armed” and “Device Triggered” are not working in IQ-

mode for RF Input with analysis bandwidths > 40 MHz and for Analog Baseband Input 

R&S FSV3-B271. 

V1.30 R&S FSV3-K6:  

When applying a trigger offset, the selected analysis bandwidth may be wider than 

expected:  

- 200 MHz in case that the bandwidth was set to 160 MHz 

- 400 MHz in case that the bandwidth was set to 320MHz or 250 MHz 
Other analysis bandwidth settings are not affected. 

There are two possibilities to avoid this issue: 

-  adjust the trigger offset before setting the analysis bandwidth. 

 set the trigger offset in two steps: set it first to any value ≠ 0 s (example 100 ns) 

and in a second step to the desired value. 

V1.10 

For Spectrum Emission Mask (SEM) and Spurious Emissions measurements: 

In cases where FFT sweep is forced (in SEM, select FFT in Sweep Config->Sweep 

Mode, or when external frontends R&S FSV3-K553 are active), the RBW filter types 

“RRC” and “5pole” are not available. Nevertheless, in the sweep list they can be 

selected. The measurement is performed with 3dB Gauss Filter instead, but no warning 

is displayed. 

V1.10 Changing the configuration of the hard key number block (Setup-> System Config -> 

Number Block Behavior) to numeric does not work. 

V1.10 In rare cases the Selftest of the device does not finish. If this happens, abort and restart 

the Selftest. 

V1.10 For IQ-Export > 600 Mio. Samples no Iq.tar preview is available and a Windows 

message warning about low memory may be displayed. This issue only occurs with 

option R&S FSV3-B114 Enhanced Computing Power. 

V1.10 R&S FSV3-K91/n/ac/ax: The R&S FSV3-K91 does not yet support the Auto Reference 

Level functionality. Before using remote control scripts developed for other R&S 

spectrum analyzers, the SCPI command [:CONF:POW:AUTO] must be commented out. 

V1.10 A message box “Warning: Missing smartcard or smartcard not initialized” may appear 

during startup of the instrument in rare cases. 

In this case, please switch the instrument off and on using the power switch on the rear 

side of the instrument or disconnect/reconnect the power line to solve this issue. 
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1.5 Optimizing 10 Gbit LAN Speed (R&S FSV3-B6) 

To obtain optimum LAN speed performance using the R&S FSV3-B6 (10Gbit/s LAN 

Interface), driver settings have to be adjusted. Here is a recommendation on how to 

adjust the settings for optimized speed: 

1. Open Windows “Start Menu”. 

2. Search for “Network and Sharing Center”. 

3. Select “Network and Sharing Center”. 

4. Select “Change adapter settings”. 

5. Select “Ethernet 3 – Intel® Ethernet Converged Network Adapter X550-T1” 

6. Select “Configure”  

7. Select Tab “Advanced” 

8. Adjust the following settings: 

─ “Interrupt Moderation” > Value: “Enabled” 

─ “Jumbo Packet” > “9014 Bytes” 

─ “Maximum Number of RSS Queues” > “16 Queues” 

─ “Performance Options” > “Properties” 

─ “Interrupt Moderation Rate” > “Off” 

─ “Receive Buffers” > “4096” 

─ “Transmit Buffers” > “16384” 

 

1.6 Windows 10 

The R&S FSV3000/R&S FSVA3000 uses the Windows 10 IoT Enterprise LTSB/LTSC 

operating system, which is the embedded version of Windows 10 with long term 

support for Windows patches. 
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2 Modifications to the documentation 

The current documentation is up-to-date.  
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3 Firmware update 

3.1 Validity information 

The R&S FSV3000 installer is valid for: 

Device Order Number 

R&S®FSV3004 1330.5000K04 

R&S®FSV3007 1330.5000K07 

R&S®FSV3013 1330.5000K13 

R&S®FSV3030 1330.5000K30 

R&S®FSV3044 1330.5000K43 

R&S®FSV3050 1330.5000K50 

  

R&S®FSVA3004 1330.5000K05 

R&S®FSVA3007 1330.5000K08 

R&S®FSVA3013 1330.5000K14 

R&S®FSVA3030 1330.5000K31 

R&S®FSVA3044 1330.5000K44 

R&S®FSVA3050 1330.5000K51 

3.2 Update information 

The firmware update file for the R&S FSVA/R&S FSV is one file including the firmware 

version number e.g. FSV3000_V1.30.exe. It is referred to as FSV3000Setup.exe later 

in the text. The file can be found on the Rohde & Schwarz web page 

https://www.rohde-schwarz.com. 

3.3 Performing the Firmware Update on the Instrument 

There are three ways to make the FSV3000Setup.exe setup file visible to the device: 

Using a memory stick:  

1. Copy the file to a directory of the memory stick. 

2. Insert the memory stick into one of the USB sockets of the R&S FSV3000. 

https://www.rohde-schwarz.com/
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Using the remote desktop and copying the installation files to a directory of the 

instrument: 

1. Connect the R&S FSV3000 to your LAN.  

2. Start the remote desktop on your PC (C:\winnt\system32\mstsc.exe).  

3. Enter the TCP/IP address of the instrument you want to update. The IP address 

consists of 4 numbers between 0 and 255.  

(To get the TCP/IP address of the R&S FSVA/R&S FSV, press the “Setup” key, 

then select “Network + Remote”.) 

4. Ensure that the "local resources" > "drives" option is selected.  

5. Press the "Connect" button.  

6. Log on to the instrument (user name: “instrument” and default password 

“894129”). 

7. Copy the FSV3000Setup.exe from your PC to a new folder, e.g. C:\FWUpdate. 

8. You can now access this directory with the FSV3000Setup.exe from the R&S 

FSVA/R&S FSV analyzer firmware. 

Using a network drive:  

1. Connect your R&S FSVA/R&S FSV to your LAN and establish a connection to 

one of your servers. (Ask the local IT administrator for support.) 

2. Copy the FSV3000Setup.exe from your PC to a directory on this server. 

3. You can now access the directory with the FSV3000Setup.exe file from the R&S 

FSVA/R&S FSV analyzer firmware. 

Performing the update on the instrument: 

Update the firmware by performing the following steps: 

1. Switch the instrument on and wait until the analyzer has resumed operation. 

2. Press the "SETUP" key, then select “System Config” > “Firmware Update” tab. 

3. A file browser is displayed to select the proper FSV3000*.exe setup file.  

4. Change the path to the drive and directory which you prepared in the step before 

(USB stick directory, remote PC directory or directory on a server). 

5. Select “Install” to close the dialog. 

6. Select "Next" to display the selection of the firmware packages. By default, all 

applications are installed. Ensure that the required applications are selected. 

7. Select "Install". 

8. The firmware is stopped and the installation starts. After a few minutes, the 

system restarts automatically. After the restart, the firmware installation is 

complete. After the firmware update, the "UNCAL" flag appears. A self alignment 

is necessary.  

9. Press the "SETUP" key, then select "Alignment" > "Start Self Alignment" to invoke 

the alignment procedure. 
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3.4 Performing the Firmware Update from a Windows PC 

The R&S FSVA/R&S FSV firmware can also be uploaded without using a memory stick 

or a network drive. Just a LAN connection from the instrument and a Windows PC is 

necessary.  

1. Run FSV3000Setup.exe on your PC. 

2. Select “Remote Installation”. 

3. Select “Next.”  

 

4. Select the packages to install. 

5. Select “Next”. 

Note:  

FOR FIREWALL USERS: The 

FSV3000Setup.exe communicates with 

the instruments via LAN. Therefore, the 

FSV3000Setup.exe file must pass the 

firewall. Add it to the firewall rules, then 

restart the scan using “Rescan”. 

 

6. The setup procedure scans your LAN subnet and displays all found instruments 

7. Select the instruments you want to update. 

 

  

 
 

 
Be careful and check twice if you have selected the correct instruments. Depending on 

your company’s network structure, also instruments of other departments are included! 

  
Select “Help” to display additional help. 

Select “Install” to start the installation. 

 

Note on package signing 

MSI package signing of setups is a security feature that was added as of firmware 

version V2.20. It prevents man-in-the-middle attacks with manipulated MSIs 

during remote firmware installation. After installing a setup file with signed MSI 

files, installing a setup file whose MSI files are not signed requires an additional 

step, if you perform the installation from a remote PC. For example, when you 

downgrade the firmware to a version prior to 2.20. In this case, you must confirm 

the less secure installation on the device. 

After starting the remote installation, the following message is shown on the 

device. 
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a) Tap the message box on the device or click on it via Remote Desktop. 

The following message is shown on the device. 

 

b) Press the keys 1,2,3. 

If you do not confirm the installation on the device, it is aborted. 

8. Confirm the message to reboot the instrument to activate the firmware update. 

The instrument then restarts automatically. 

9. After the restart, the firmware installation is complete and the "UNCAL" flag 

appears. A self alignment is necessary.  

10. Press the "SETUP" key, then select "Alignment" > "Start Self Alignment" to invoke 

the alignment procedure. 

 

 

3.5 Installing firmware options 

3.5.1 Firmware options included in basic instrument 

The R&S FSV3-K7, R&S FSV3-K9, R&S FSV3-K33, R&S-K553, R&S FSV3-K544, 

R&S FSV3-K703 and R&S FSV3-K980 application software packages are included in 

the basic instrument firmware. Therefore, they do not have a separate item in the 

installer to be selected. 
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3.5.2 Other firmware options within the FSV3000setup.exe File 

The R&S FSV3-K6, R&S FSV3-K8, R&S FSV3-K10, R&S FSV3-K18, R&S FSV3-K30, 

R&S FSV3-K40, R&S FSV3-K60, R&S FSV3-K70, R&S FSV3-K72/73, R&S FSV3-

K91, R&S-K96, R&S FSV3-K100/101/102/104/105/106, R&S FSV3-

K144/145/147/147C/148/171/175 application software packages have their own 

installation item and are therefore added to the selection list during the firmware 

update. Ensure that the checkbox is checked  if the installation is requested. 

 
 

 

The functionality of R&S FSV3-K18D, R&S FSV3-K18F, and R&S FSV3-K18M is 

integrated within R&S FSV3-K18 and is activated by its own key code. 

The functionality of R&S FSV3-K70M, R&S FSV3-K70P are integrated within R&S 

FSV3-K70 and are activated by their own key code. 

The functionality of the R&S FSV3-K91P, R&S FSV3-K91N, R&S FSV3-K91AC, R&S 

FSV3-K91AX and R&S FSV3-K91BE are integrated within R&S FSV3-K91 and are 

activated by their own key code. 

The functionality of the R&S FSV3-K60C, R&S FSV3-K60H and R&S FSV3-K60P are 

integrated within R&S FSV3-K60 and are activated by their own key code. 

  
 

3.5.3 Enabling options by entering option key codes 

  

 
 

 Skip this section if the option key was entered once. 

  
 

To activate application software packages, you must enter a license key for validation. 

If an XML-file with an option key was sent to you see the install description below. 

The license key is in the device certificate or delivered as a part of the software 

package. The process is performed in the following steps: 

1. Open a Remote Desktop Connection to the instrument via ethernet or 

connect an external monitor and keyboard/mouse] 

2. Select "SETUP". 

3. Go to the tab “Versions + Options” 

4. Press the button "Install Option". 

A dialog box is displayed. 

5. Enter the option key number using the keypad. 

6. Press "ENTER". 

After a successful validation the message "Option Key valid" is displayed. If the 

validation failed, the option software is not installed.  

7. Reboot the device. 
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Installation of options via XML-file 

1. Open a Remote Desktop Connection to the instrument via ethernet or 

connect an external monitor and keyboard/mouse] 

2. Select "SETUP". 

3. Go to the tab “Versions + Options” 

4. Press the button "Install Option by XML". 

A file browser is displayed. 

5. Select the path to the XML file (e.g. network drive or USB stick) 

6. Press "Select". 

After a successful validation the message "Option Key valid" is displayed. If the 

validation failed, the option software is not installed.  

6. Reboot the device. 
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4 Customer support 

Technical support – where and when you need it 

For quick, expert help with any Rohde & Schwarz product, contact our customer 

support center. A team of highly qualified engineers provides support and works with 

you to find a solution to your query on any aspect of the operation, programming or 

applications of Rohde & Schwarz products. 

Contact information 

Contact our customer support center at www.rohde-schwarz.com/support 

or follow this QR code: 

 

QR code to the Rohde & Schwarz support page 

 

 

http://www.rohde-schwarz.com/support
http://www.rohde-schwarz.com/support

